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CHAPTER 5 WORKING WITH CONNECTORS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In some drawings, like flowcharts and organisational charts, you 
need to connect shapes to indicate the flow of the operation, 
procedure or logic. 

In Visio, the lines connecting two objects are called connectors. A 
connector attaches itself to a connector point on a shape or to the 
shape itself. 

Shapes can be connected as they are drawn or you can place the 
shapes on the page first and then draw the connectors at a later 
stage. 

In this session you will: 

 gain an understanding of how to connect shapes in Visio 

 learn how to automatically add connected shapes 

 learn how to connect exisiting shapes 

 learn how to insert and delete shapes in a connected 
diagram 

 learn how to add text to connectors 

 learn how to change connectors 

 learn how to work with connection points 

 learn how to format connectors. 
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CONNECTING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The shapes drawn from some stencils (e.g. 
flowcharts) have connection points. These 
points enable you to draw connectors between 
shapes to display a relationship between them. 

The connectors can be attached to the shapes 
using either dynamic or point glue. Glue is a 
property that keeps shapes connected even when 
they are moved to new positions. 

Connections 

There are two main types of connections in Visio: dynamic and point. What differentiates these 
two connections is whether or not a connector remains glued to a specific connection point when 
you move the attached shape. 

A dynamic connection is one where the connector will move around the shape as you move the 
shape. Visio will always ensure the connector is the shortest, most direct line possible. You create 
a dynamic connection by selecting the entire shape (rather than the connection point) and connect 
it to another shape (rather than to a connection point). 

A point connection is one where the connector is glued on a connection point of a shape. When 
you move this shape, the connector may change shape (i.e. to allow for other shapes in its way) 
but the connector will always remain attached to the same connection point. You create a point 
connection by connecting a specific connection point on one shape to another connection point on 
another shape. 

Until you select a connector or move one of the attached shapes, you cannot differentiate a 
dynamic connector from a point connector. Below, we have selected both connectors so you can 
see how they differ. Both ends in a dynamic connector are surrounded by a blue box, while the 
start point of a point connector is a hollow red box and its end point is a solid red square. 

Connection Points 

A connection point is a special point on some shapes to which you can attach (or glue) 
connectors and other shapes. A connection point appears as a blue x – for example, the Create 
request and Decision shapes below each have four connection points. 

When you glue a connector to a connection point on a shape, the shape and connector will stay 
connected even if you move the shape as you can see in the example below. 

In Visio 2010, connection points only become visible when you attempt to connect a shape to 
another shape. You will see a shape’s connection points when you hover near a shape using the 
Connector tool or drag the endpoint of a connector or line near a shape that has connection 
points. 

Connection point 

Connector 

Dynamic connection Point connection 
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AUTOMATICALLY ADDING CONNECTED SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Try This Yourself: 
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 Before starting this exercise you 

MUST open V505 Working With 
Connectors_1.vsd... 

 Hover over the Build model 
Process (rectangle) shape until 
the blue AutoConnect arrows 
appear around the shape 

 Hover over the bottom 
AutoConnect arrow to display a 
mini toolbar with the top four 
Quick Shapes from the open 
Basic Flowchart Shapes 
stencil 

A preview of the shape that is 
currently selected in the stencil 
appears on the page… 

 Move the pointer over the four 
shapes to see a live preview of 
each shape on the page 

 Click on the Decision 
(diamond) shape, then type 
accepted and click outside the 
shape 

Let’s add another shape… 

 Click on Document in the 
Shapes window to select this 
shape in the stencil 

 Hover over the first Decision 
shape, then hover over the 
bottom AutoConnect arrow 

 Click on the AutoConnect arrow 
to add the Document, then 
type Write problem report 

 

For Your Reference… 

To automatically add connected shapes: 

1. Click on the shape in the stencil to be added 

2. Hover over the shape in the drawing, then 
hover over the desired AutoConnect arrow 

3. Click on the Quick Shape in the mini toolbar 
or click on the AutoConnect arrow to add the 
selected shape 

Handy to Know… 

 You can turn AutoConnect on or off in the 
active drawing by ticking or clearing 
AutoConnect in the Visual Aids group on 
the View tab. You can turn it on or off for all 
drawings in the Options dialog box. Click on 
File, Options, Advanced and tick or clear 
Enable AutoConnect in Editing options. 

 

1 

2 

The AutoConnect feature in Visio lets you 
quickly add connected shapes to your drawing 
that are evenly spaced and aligned. You can 
either add the shapes by selecting one of the four 

Quick Shapes in the mini toolbar, or you can  
pre-select the desired shape in the Shapes window 
and simply click on the AutoConnect arrow pointing 
in the direction where you want to add the shape. 

7 

Connections created using AutoConnect are 
dynamic connections. 
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CONNECTING EXISTING SHAPES 
 

 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

     

Try This Yourself: 
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 Continue using the previous file or 

open V505 Working With 
Connectors_2.vsd... 

 Hover over the Start shape to 
display the AutoConnect arrows, 
then hover over the bottom arrow to 
display a preview of a connector  

 Click on the AutoConnect arrow to 
insert the connector, then drag the 
shape to a location similar to as 
shown to see that the connector can 
move to a different connection point 
– this is a dynamic (shape to shape) 
connection 

 Hover over the Develop Process 
shape, then click and drag the 
bottom AutoConnect arrow until the 
connection point is highlighted, as 
shown, then release the mouse 
button – this is a shape to point 
connection 

 Drag the Develop Process shape 
back to its original position – the 
connector will attach to the 
connection point closest to the 
Decision shape 

 Click on the Connector tool  in 

the Tools group, then hover over the 
right connector point of the top 
Decision shape to select it 

 Click on the connector point, then 
drag to the centre of the Build 
Process shape, as shown, then 
release the mouse button to create a 
point to shape connection 

 

For Your Reference… 

To connect existing shapes with a point to 
shape/point connection: 

1. Click on the Connector tool  

2. Click on the connection point and drag to 
either the shape or connection point 

3. Release the mouse button 

Handy to Know… 

 You can connect shapes using a connector 
shape from a stencil. Once you have 
dragged the connector onto the page, drag 
each end of the connector to the desired 
connection point and glue it in position. If you 
are using a dynamic connector shape, you 
can glue it to the shape or connection point. 

 

2 

You can connect existing shapes in a drawing 
using AutoConnect (with the Pointer tool) or 
manually with the Connector tool. To create a 
point connection on the first shape (connecting 

from a connection point to another point or shape), 
you must use the Connector tool. By default, 
AutoConnect creates a dynamic connection 
glueing the start of a connector to the shape. 

3 

5 

6 

You can use the Connector tool  to create all four connector 

types: shape to shape, shape to point, point to shape, and point to 

point. Using the Pointer tool  and AutoConnect, you can only 

create shape to shape and shape to point connectors. 
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INSERTING AND DELETING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Try This Yourself: 
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 Continue using the previous 

file or open V505 Working With 
Connectors_3.vsd... 

 Drag the Document shape 
from the Basic Flowchart 
Shapes stencil onto the 
connector between the Start 
and Develop Process shapes 
until the two red connection 
handles appear 

 Release the mouse button 

The surrounding shapes will 
move automatically making 
room for the shape and a new 
connector will be added. 

You can easily remove shapes 
as well… 

 Ensure the new Document 
shape is selected, then press 

 

The two connectors will be 
replaced by a single connector 
between the remaining 
shapes. Let’s correct the 
spacing now… 

 Click on the Pointer tool , 

then select both the Start and 
Develop Process shapes, 
then click on Auto Align & 
Space  in the Arrange 

group 

 

For Your Reference… 

To insert a shape with automatic adjustment: 

1. Drag a shape to be inserted onto a 
connector 

To delete a shape with automatic adjustment: 

1. Select the shape and press  

2. Select the shapes then click on Auto Align 
& Space  to correct the spacing 

Handy to Know… 

 Visio does not automatically close up the 
space when you delete a shape from a linked 
sequence of shapes as this might not be the 
action you desire. 

 You can adjust all shapes in a diagram at the 
same time by selecting them and then 
clicking on Auto Align & Space . 

1 

2 

If you have already created much of your 
flowchart but you need to add or remove shapes, 
it’s no problem. As you insert a shape, Visio will 
connect the shapes, repositioning shapes as 

necessary. When you delete a shape, Visio will 
automatically connect the remaining shapes but 
without repositioning them. However, using Auto 
Align & Space you can correct this with a click. 

3 

4 

If you want to 
ensure that the 
spacing between 
every shape in a 
drawing is 
consistent, click on 
Position in the 

Arrange group 
and select Auto 
Space. 

You can change 
the layout of a 
flowchart 
automatically in 
Visio. To do this, 
click on Re-
Layout Page  

in the Layout 
group on the 
Design tab and 
hover over the 
various options to 
see a Live Preview 
of the diagram. 
Click on the 
desired option. 
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ADDING TEXT TO CONNECTORS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file V505 Working With 
Connectors_4.vsd... 

 Click on the Pointer tool  in 

the Tools group 

 Click on the connector 
between the accepted 
Decision shape and the Build 
Process shape to select it 

 Type Yes 

Visio will automatically add the 
text to the selected connector. 
Visio may also zoom in if you 
are working at a magnification 
less than 100% so that you 
can see what you are typing… 

 Click outside the text to 
indicate that you have finished 
entering the text 

You could have also pressed 

… 

 Repeat the above steps to add 
No between the Decision 
shape and the Document 
shape 

 

For Your Reference… 

To add text to a connector: 

1. Click on the connector using the Pointer  
tool  

2. Type the desired text 

Handy to Know… 

 You can format or edit the text on a 
connector. To do this, select the connector 
by clicking on it with the Pointer tool  then 

click on the Text tool  in the Tools group 

to select the text. 

 

2 

3 

In some instances, you may need to add text to a 
connector. In a flowchart, for example, you might 
need to indicate the direction of flow based on 
the outcome of a decision. If the outcome is 

positive, the flow will continue in one direction but if 
the outcome is negative, then the flow will be 
redirected elsewhere. 

4 

5 
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CHANGING CONNECTORS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

Try This Yourself: 
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 Continue using the previous 

file or open V505 Working With 
Connectors_5.vsd... 

 Use the Connector tool  to 

create a point to point 
connection as shown 

You can manipulate a 
connector… 

 Click on the Pointer tool  

then drag the two midpoints 
(the blue squares) and vertex 
(blue diamond) on the 
connector as desired 

You can change the connector 
to a different type of line… 

 Click on the Design tab, then 
click on Connectors  in the 

Layout group and select 
Straight Lines 

 Repeat step 3 but select 
Curved Lines and then 
manipulate it as desired 

Using the Connectors menu 
you can also add line jumps… 

 Using AutoConnect, create a 
connector from the bottom of 
the Develop Process and glue 
it to the bottom of the Build 
model Process 

 Repeat step 3 and select 
Show Line Jumps, then press 

 

 

For Your Reference… 

To manipulate a connector: 

1. Click on the connector (Pointer tool ) 

2. Click on Connectors  in the Layout 

group and selected the desired line type 

3. Drag the vertices and midpoints as needed 

Handy to Know… 

 If you want to reverse the direction of a 
connector, select the connector, press   

to delete it, and then create a new connector 
in the correct direction. 

 You can use different Line jumps settings by 
clicking on the dialog box launcher  for 
Layout (on the Design tab).  

 

1 

2 

Sometimes, the path that a connector makes 
between two shapes is not quite right. You can 
manipulate a connector to reshape it. You can 
also change the type of line that is used for a 

connector from being right-angled to either curved 
or straight. If you have connectors crossing other 
connectors in more complex flowcharts, you can 
change the way the lines appear where they cross.  

3 

6 

You can create a new 
vertex in a connector 

by holding  while 

dragging a midpoint. 

You can add extra 
sections to a 
connector by holding 

 while dragging a 

vertex or midpoint. 
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WORKING WITH CONNECTION POINTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the previous 

file or open V505 Working With 
Connectors_6.vsd... 

 Click on the Connection Point 
tool  in the Tools group on 

the Home tab 

The existing connection points 
will display. Let’s add a new 
connection point… 

 Click on the Develop Process 
shape to select it, then hold 

 and click to the right of the 

bottom connection point 

The connector will 
automatically move to the new 
connection point… 

 Repeat step 2 to add a new 
connection point to the left of 
the bottom point on the Build 
Process shape 

Let’s move the connector to 
the new connection point… 

 Click on the Pointer tool , 

then click on the connector 
between the two Processes 

 Drag the far right midpoint until 
it is to the left of the other 
vertical connector, then drag 
the red endpoint over your new 
connection point – it will be 
highlighted in red as shown – 
then release the mouse button 

 

For Your Reference… 

To add a connection point: 

1. Click on the shape 

2. Click on the Connection Point tool  

3. Press  and click where desired 

Handy to Know… 

 You can move a selection point. Select the 
shape, click on the Connection Point tool 

 and drag the connection point as desired. 

 To delete a connection point, select the 
shape, click on the Connection Point tool 

, click on the connection point and press 

. 

 

2 

3 

A connection point is a special point on some 
shapes to which you can glue connectors and 
other shapes. Although Visio provides a specific 
number of connection points in default locations, 

you can easily add additional points if you want to 
glue a connector in a non-standard location. You 
can also move and delete unwanted connection 
points. 

5 
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FORMATTING CONNECTORS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the previous 

file or open V505 Working With 
Connectors_7.vsd... 

 Click on the Pointer tool , 

then click on the connector 
between the Document and 
the Develop Process 

 Click on the drop arrow  for 
Line  in the Shape group 

and select Line Options to 
open the Line dialog box 

 Click on the drop arrow  for 
Dash type and select 02  

 Click on the drop arrow  for 
Weight and select 3 pt 

 Click on the drop arrow  for 
Colour and click on the first 
colour under Standard 
Colours (Dark Red) 

 Click on the bottom left Round 
corners option 

 Click on [OK], then press  

to deselect the line 

 

For Your Reference… 

To format a connector: 

1. Select the connector/s 

2. Click on the drop arrow  for Line  and 

select Line Options 

3. Select the required options 

4. Click on [OK] 

Handy to Know… 

 You can change a connection from being 
dynamic to point and vice versa. To do this, 
select the connector and then drag the 
connector end point away from the shape. 
Drag and drop the connector on a connection 
point for a point connection, or on the middle 
of the shape for a dynamic connection. 

2 

5 

There are multitudes of styles that you can apply 
to connectors to differentiate or highlight them. 
You may choose to alter the line width, colour or 
pattern, or you might want to have rounded lines 

rather than straight ones. You can also change the 
beginning and ending styles of connectors. These 
detailed formats mean that drawings can meet 
even the most stringent of design criteria. 

6 

7 
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